IRA Basic

Running Financial Reports

Updated 6-7-2013
Dartmouth College – Working with IRA Reports

Training Index

- Part I Introduction to the IRA Reporting Tool
  - IRA Resources (3)
  - Logging onto the system (4)
  - Navigating the Dashboard (5-9)
  - Running Reports (10-11)
  - Working with Reports (12-13)
  - Working with Filters (14-22)
  - Working with Reports, continued (23-30)
  - Saving Filters and Report Views (31-33)
  - Working with downloadable tables (34-35)
  - Printing Reports (36)
  - Exporting Reports (37)
  - Signing Out (38)

- Part II Customizing Standard Reports (39-56)

- Part III Additional Navigation (57-66)

For help email Financial.Reports@dartmouth.edu
IRA Resources

- Help/User Support:
  - Send e-mail to financial.reports@dartmouth.edu
  - Or contact the financial analyst assigned to your division or school for help customizing reports.

- Training materials and other information about IRA posted at
  - [http://www.dartmouth.edu/~control/training/index.html](http://www.dartmouth.edu/~control/training/index.html)
  - [http://www.dartmouth.edu/~control/accounting/](http://www.dartmouth.edu/~control/accounting/)
Accessing IRA

- Open a browser window (Internet Explorer or Firefox) and navigate to: https://ira.dartmouth.edu/analytics/saw.dll?Dashboard

  • Net ID is your Employee ID - DID# preface with the letter “d” or “f” if it begins with a number.
  • Password is your E-Mail password.

  • This is the same User ID and Password you use to login to your computer and login to email.
NAVIGATION – Application Level Navigating

Application Level Navigation Links

Note: Because of security setups, your dashboards may vary from this example.

For help email Financial.Reports@dartmouth.edu
NAVIGATION – Dashboard Overview

Selected Dashboard

Available Dashboards

Report Link

Section Name

Section

For help email Financial.Reports@dartmouth.edu
NAVIGATION – Dashboards Overview

Select the Launchpad Dashboard.

Additional reports are grouped by subject area on separate tabs.

Current tab is white and moves to “front”

For help email Financial.Reports@dartmouth.edu
NAVIGATION – Dashboards Overview

- Related reports are grouped in sections
NAVIGATION – Dashboards Overview

- Report Links appear in sections and on page tabs
- The Reports **Home Page** tab is visible to everyone
- Report Links are Grouped by:
  - Report Type
  - Area / Department / Users
- Tabs, sections, or reports may not be visible depending on user’s security access

For help email Financial.Reports@dartmouth.edu
To Run a Report:

- Select the appropriate Report tab. This would typically be the Home Page tab.
- Select the link that corresponds to the report name.

For help email Financial.Reports@dartmouth.edu
NAVIGATION – Running Reports

- When selected, the report will open in either a separate window or on a separate tab depending on your browser version and settings.

Report opens in a new window in Internet Explorer

Report opens in a new tab or new window in Mozilla Firefox

For help email Financial.Reports@dartmouth.edu
Note: Some reports may have multiple report tabs above the Report Header.
The report name, ID, and version, and date and time executed are key pieces of information in resolving issues when running reports. Please include this info when e-mailing Help/User Support (Financial.Reports@dartmouth.edu).
Filter selections can be saved for future use.

Leaving a filter value blank will return all data for all relevant values under that filter. The report will run faster than choosing all values for a filter.

For help email Financial.Reports@dartmouth.edu
WORKING WITH FILTERS – Filter Types

1. Dropdown to choose one value

2. Text Box (can type directly in) or Calendar Search

3. Select one or more values
   Note: De-Select Default Filter Value
   Or Click on More/Search for Select Dialog Box

For help email Financial.Reports@dartmouth.edu
Selecting or Searching for Values:

- Values will "Populate"
- Click to Select and/or De-Select Values from the Drop Down List
- After Values Selected Click outside the Filter List to add as a Filter(Prompt)

1. Click to Displays List of Values
2. Click on Search to open Select Values
   - Click to De-Select or Select. Then click outside the Filter List

For help email Financial.Reports@dartmouth.edu
WORKING WITH FILTERS – Multi Select Filters

- Move values from left to right to select them, and right to left to de-select.

**NOTE:** If there are more than 256 applicable values, you need to click on the "More" button to display all available values.

Select options:
- Move All
- Move one or more values
- Double click on an individual value to move it from right to left or left to right

**NOTE:** If there are more than 256 applicable values, you need to click on the "More" button to display all available values.
WORKING WITH FILTERS – Multi Select Filters

- Select a Single Value:
  - Select the value from the Available Values list.
  - Select the Single Left Arrow button to move the selected item to the list of Selected Values. Or, double-click on the value.
  - Select the OK button to add this value as a filter (prompt).

For help email Financial.Reports@dartmouth.edu
Select Multiple Values:

- Select the values from the Available Values list. (Ctrl + click or Shift + click)
- Select the Single Arrow / Move button to move the selected Value(s) to the list of Selected Values.
- Select the OK button to add these values as a filters (prompts).

For help email Financial.Reports@dartmouth.edu
WORKING WITH FILTERS – Multi Select Filters

- Searching for Values
  - Starts
  - Contains
  - Ends
  - Is LIKE (wild card)
- Select Search to see matching results
- Once the results are returned, continue with a single, multiple, or ALL selection.

For help email Financial.Reports@dartmouth.edu
WORKING WITH FILTERS – Multi Select Filters

- **Edit** Function – Save a list of values, copy and paste values from another source, or type in a list of values.
  - Select the Values and move them to the Selected area
  - Click the Edit Button
  - Highlight, then copy and paste the items into Notepad, Word, or Excel
  - Save this file to have the list ready for future use
  - To reuse this list in a future filter, click on the Edit button and paste the values from Notepad, Word, or Excel into the Edit box and click OK.
  - Or click Edit and paste a list from an external source into the Edit box.
  - Or type directly into the Edit box

For help email Financial.Reports@dartmouth.edu
WORKING WITH FILTERS – The Cascading Effect

- Filters will Cascade:
  - Each filter selection will narrow the choices available in subsequent filter selections
  - Works both Forward and Backwards (left and right)
- Cascading follows Org Security rules
- There may be a lag while values populate based on previous choices

Initial Selection of UPNE Entity

Subsequent list of values includes only UPNE Org Values

Lists includes only UPNE Org Funding Values

For help email Financial.Reports@dartmouth.edu
WORKING WITH REPORTS – Report Sections

- View Selector
- Group By Selector
  - Controls how the data is sorted and summed
- Totals
  - Subtotals
  - Section Totals
- Report Totals
- Control Buttons
  - Analyze
  - Print
  - Export

For help email Financial.Reports@dartmouth.edu
Some reports will not have a view selector since they only have one view.

For help, email Financial.Reports@dartmouth.edu
WORKING WITH REPORTS – Select a View

- Report Information is usually the default option.

- Selection Criteria view shows the filter selections (prompts) applied when the report ran.

For help email Financial.Reports@dartmouth.edu
WORKING WITH REPORTS – Group By Selector

- Controls how report output is grouped or organized, subtotaled, and sorted.

Choose to view all pages, or by a single segment value:

For help email Financial.Reports@dartmouth.edu
WORKING WITH REPORTS – View Selector

- No Results
  - If no Data was returned, the View Selector will not be visible. Instead, the No Results information will be displayed.

  ![No Results](image)
  
  The specified criteria didn't result in any data. This is often caused by applying filters that are too restrictive or that contain incorrect values. Please check your Request Filters and try again. The filters currently being applied are shown below.

- Rows Returned Message
  - This is information regarding the amount of data returned. It is also a warning regarding large data sets; recommending downloading the data rather than selecting a report view to display the report in your browser.

  ![Rows Returned](image)
  
  Important:
  For results sets greater than 4000 rows, trying to view "All Pages" of the Report or all rows of the Downloadable Table in the browser may result in unacceptaable response times. Using the "Download Data" option to Excel will yield more immediate results.

  Rows Returned = 2167
WORKING WITH REPORTS – Report Totals

For help email Financial.Reports@dartmouth.edu

Group By: Org

Select a View: Report

Row Amounts

Sort

Subtotals (on Natural Class 7711)

Section Totals (On Org 545)

Report Grand Totals (by Org since Group By: Org chosen)

<table>
<thead>
<tr>
<th>Natclass</th>
<th>Effective Date</th>
<th>JE Source Short Name</th>
<th>JE Batch Name</th>
<th>JE Line Description</th>
<th>Budget Amount</th>
<th>Actual Amount</th>
<th>Encumb Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>7711-PROF FEES ACCOUNTING Accounting</td>
<td>3/25/2013</td>
<td>Payables</td>
<td>Payables A 5415187 12429534</td>
<td>Journal Import Created</td>
<td>0.00</td>
<td>954.89</td>
<td>0.00</td>
</tr>
<tr>
<td>7711-PROF FEES ACCOUNTING Accounting</td>
<td>3/25/2013</td>
<td>Payables</td>
<td>Payables A 5415187 12429534</td>
<td>Journal Import Created</td>
<td>0.00</td>
<td>3,150.00</td>
<td>0.00</td>
</tr>
<tr>
<td>7711-PROF FEES ACCOUNTING Accounting</td>
<td>4/2/2013</td>
<td>Payables</td>
<td>Payables A 5737189 12691019</td>
<td>Client# 140139.00</td>
<td>0.00</td>
<td>2,000.00</td>
<td>0.00</td>
</tr>
<tr>
<td>7711-PROF FEES ACCOUNTING Accounting</td>
<td>4/23/2013</td>
<td>Payables</td>
<td>Payables A 7210193 13065526</td>
<td>Journal Import Created</td>
<td>0.00</td>
<td>20,825.00</td>
<td>0.00</td>
</tr>
<tr>
<td>7711-PROF FEES ACCOUNTING Accounting Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>26,919.89</td>
<td>0.00</td>
</tr>
<tr>
<td>Grand Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00</td>
<td>26,919.89</td>
<td>0.00</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Org</th>
<th>Budget Amount</th>
<th>Actual Amount</th>
<th>Encumb Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>545-Financial Reporting</td>
<td>0.00</td>
<td>25,919.89</td>
<td>0.00</td>
</tr>
<tr>
<td>546-Accounting Operations</td>
<td>0.00</td>
<td>-28.25</td>
<td>0.00</td>
</tr>
<tr>
<td>547-Controllers Ofc</td>
<td>0.00</td>
<td>2,338.70</td>
<td>0.00</td>
</tr>
<tr>
<td>Grand Total</td>
<td>0.00</td>
<td>25,230.34</td>
<td>0.00</td>
</tr>
</tbody>
</table>
WORKING WITH REPORTS – Report Totals

- Report Grand total
  - Usually a separate section at the end of the report.
  - Is often displayed immediately after the report is run even when the Report View has not yet been chosen.
  - In some reports the Report Grand Totals are linked to the Group By selector.

![Image of a report with Grand Total section and Group By selection]

For help email Financial.Reports@dartmouth.edu
Some Reports Consist of Additional Tabs or Pages

Visible above the Report Header if available

Examples:
- Segment Lookup
- RFM Funding Report

For help email Financial.Reports@dartmouth.edu
SAVING FILTERS AND REPORT VIEWS - Save

- To make running reports more efficient, both filter values and preferred report views can be saved. They can then be used in future IRA sessions.

1. Choose applicable Filter Values

2. Run the Report

3. After data is returned, choose the report View and Group By value you would prefer to save

4. Choose Page Options, Save Current Customization

5. Name the filter/view combination

6. (Optional) Check to set as Default. This means this filter/view will run when the report link is clicked

7. Choose for Me

8. Click OK to save.

Page Options Icon is on top right of screen

For help email Financial.Reports@dartmouth.edu
SAVING FILTERS AND REPORT VIEWS – Run Saved Report

To run a saved report, open the report link and choose Page Options -> Apply Saved Customization -> saved report name:

1. Page Options (located top right)

2. Apply Saved Customization

3. Choose Saved Report

This will automatically run the report using saved filters, and return data in the saved report view format. Data will be refreshed with up-to-date information.

To adjust the filters of a saved report before processing, choose a saved report and click here to cancel processing. Change your filters and click Apply to process.

For example, a report of several funding values could be saved and selected, but the Searching cancelled so the user could update the specific period to run.

Note: Saved selections are specific to each report. For example, criteria saved under the GL Transactions report will not be available under GL Rollup Report.
SAVING FILTERS AND REPORT VIEWS - Manage

- To manage your saved report and filters, open the report link and choose Page Options → Edit Saved Customizations:
  - Rename an existing saved report
  - Radio button controls which saved report is the default
  - Click OK to save your changes
  - Delete an existing saved report

For help email Financial.Reports@dartmouth.edu
WORKING WITH DOWNLOADABLE TABLES

- Select the Downloadable Table view from the report View Selector
- All data is shown, regardless of Group By selection

Buttons located bottom center of table:

- Display first 100 rows of data
- Page forward in increments of 100 rows
- Page back in increments of 100 rows
- Display All up to a maximum 5000 rows
- Default displays the first 100 rows of data

IMPORTANT:
For results sets greater than 4000 rows, trying to view "All Pages" of the Report or all rows of the Downloadable Table in the browser may result in unacceptable response times. Using the "Download Data" option to Excel will yield more immediate results.

Rows Returned = 2167

For help email Financial.Reports@dartmouth.edu
WORKING WITH DOWNLOADABLE TABLES

For rows that are not Budget or Encumbrance transactions, the Encumb Type and Budget Name will be populated with “Invalid” or “unknown”. This does not indicate an error.

Data in the Downloadable Table is sorted by the Group By segment value selected.

Same data, sorted by Group By:
PRINT OPTIONS

For PDFs:

Select the Print link and choose PDF option

PDF opens in a separate window and can be printed or saved
EXPORT REPORTS AND TABLES

- Export options can be used with any report view:
  - Excel downloads what is on the screen with formatting.
  - CSV (comma-separated text, unformatted). Downloads the detail data behind the report not what is shown on the screen.
  - Tab delimited format (tab-separated text, unformatted). Downloads the detail data behind the report not what is shown on the screen.
  - Download to PDF or PowerPoint will save the report or table in that file format.

1. Select the Export link and choose option
   - Option: Choose Excel to keep formatting
   - Option: Choose CSV Format if plan to do more analysis outside IRA
   - Open with Excel or Save

For help email Financial.Reports@dartmouth.edu
EXITING IRA (Sign Out)

- Close all open IRA browser windows except the main dashboard page.
- Select the Sign Out option at the top right of the main IRA browser window.

For help email Financial.Reports@dartmouth.edu
IRA - CUSTOMIZING STANDARD REPORTS
Customizing Standard Reports – Overview

1. Any report and view can be customized
2. Run the report you want to customize
3. Save the report before making changes
4. Right click on column header to view customize options
5. Click on column header to “drag” and “drop” and reorder rows or columns

Use the commands available on each column.

Additional/specific options open up when command highlighted

“Handle” for rearranging columns

Some have option to “Return” to previous view - don’t use browser “back” function

Located on each data field

Links located at bottom, middle of screen

Note: Detailed instructions on following slides

For help email Financial.Reports@dartmouth.edu
Customizing Standard Reports - Sorting

To sort by any one column:
- Right Click to sort by multiple columns
- Choose Sort option
- Add ascending or add descending to sort within an existing sort

In this example sort is first by natural class then JE Source Short Name

For help email Financial.Reports@dartmouth.edu
### Customizing Standard Reports – Keep Only

For help email Financial.Reports@dartmouth.edu

#### Additional Options
- Depend upon prior Option

**Right Click**
- Highlight to see options
- Options

<table>
<thead>
<tr>
<th>NameClass</th>
<th>Effective Date</th>
<th>JE Source Short Name</th>
<th>JE Line Description</th>
<th>JE Line</th>
<th>Budget Amount</th>
<th>Actual Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>4969-INT DEPT Services</td>
<td>4/30/2013</td>
<td>Recurring</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4969-INT DEPT Services</td>
<td>4/30/2013</td>
<td>Recurring</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4859-INT DEPT Services Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6145-SAL EXEMPT STAFF</td>
<td>4/30/2013</td>
<td>OGL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6145-SAL EXEMPT STAFF</td>
<td>5/31/2013</td>
<td>OGL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6145-SAL EXEMPT STAFF Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6505-FB DEPT CHARGES Exempt</td>
<td>4/30/2013</td>
<td>OGL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6505-FB DEPT CHARGES Exempt</td>
<td>5/31/2013</td>
<td>OGL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6505-FB DEPT CHARGES Exempt Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7505-SUPPLIES Food and Beverage</td>
<td>4/13/2013</td>
<td>PCARU.DC</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Customizing Standard Reports - Remove

- Right Click
- Highlight to see options
- Options
- Additional Options Depend upon prior Option

<table>
<thead>
<tr>
<th>Netclass</th>
<th>Effective Date</th>
<th>JE Source Short Name</th>
<th>JE Batch Code</th>
<th>JE Line Description</th>
<th>Budget Amount</th>
<th>Actual Amount</th>
<th>Encumb Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>4869-INT-DEPT Services</td>
<td>4/30/2013</td>
<td>Recurring</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4869-INT-DEPT Services</td>
<td>4/30/2013</td>
<td>Recurring</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4869-INT-DEPT Services Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6145-SAL-EXEMPT STAFF Regular Staff</td>
<td>4/30/2013</td>
<td>OLD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6145-SAL-EXEMPT STAFF Regular Staff</td>
<td>5/31/2013</td>
<td>OLD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6145-SAL-EXEMPT STAFF Regular Staff Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6505-FB-DEPT CHARGES Exempt Full Benefit</td>
<td>4/30/2013</td>
<td>OLD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6505-FB-DEPT CHARGES Exempt Full Benefit</td>
<td>5/31/2013</td>
<td>OLD</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6505-FB-DEPT CHARGES Exempt Full Benefit Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7503-SUPPLIES Food and Beverage</td>
<td>4/16/2013</td>
<td>PCARD_DC</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For help email Financial.Reports@dartmouth.edu
# Customizing Standard Reports – Subtotals

For help email Financial.Reports@dartmouth.edu

---

**Add or remove subtotal**

**Note:** Sort data before subtotaling.
Customizing Standard Reports – Grand Totals

For help email Financial.Reports@dartmouth.edu

**Adds Grand Total to bottom of Report**

**Report View has Grand Total – option to move to top or remove**
Customizing Standard Reports – Column Totals

Pivot Table (Budget and Encumbrance Columns Excluded)

Before - No Column Totals

After - Column Total added

Remove or Add Total Column

For help email Financial.Reports@dartmouth.edu
**Customizing Standard Reports – Exclude Column**

To exclude a column in the report, you can right-click on the column header and select the Exclude Column option. Excluded columns can be re-included using the Include Column option.

<table>
<thead>
<tr>
<th>Naclid</th>
<th>Effective Date</th>
<th>JE Source Short Name</th>
<th>JE Batch Name</th>
<th>JE Line Description</th>
<th>Budget Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>4859-INT DEPT Services</td>
<td>3/31/2013</td>
<td>Recurring</td>
<td>FY13 Recurring Entries: 03-APR-13 13:31:29</td>
<td>Comp to Debt Banks</td>
<td>0.00</td>
</tr>
<tr>
<td>4859-INT DEPT Services</td>
<td>3/31/2013</td>
<td>Recurring</td>
<td>FY13 Recurring Entries: 03-APR-13 13:31:29</td>
<td>Endowment Tax Services</td>
<td>0.00</td>
</tr>
<tr>
<td>4859-INT DEPT Services</td>
<td>4/30/2013</td>
<td>Recurring</td>
<td>FY13 Recurring Entries: 03-MAY-13 14:32:09</td>
<td>Comp to Debt Banks</td>
<td>0.00</td>
</tr>
<tr>
<td>4859-INT DEPT Services</td>
<td>4/30/2013</td>
<td>Recurring</td>
<td>FY13 Recurring Entries: 03-MAY-13 14:32:09</td>
<td>Endowment Tax Services</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Note:** Excluded columns can be re-included using the Include column option.
Customizing Standard Reports– Include Columns

Report with Budget and Encumbrance Columns Removed

1. Right click in header area
2. Highlight Include
3. Select Item(s) from list
4. Column Added
Customizing Standard Reports – Hide Columns

Right Click on column to hide

Note: We recommend using “Exclude” rather than “Hide” as you are not always able to re-include the column after hiding.
Customizing Standard Reports – Move Columns

Use right click functionality

1. Right Click on Column to move
2. Choose move option

Or use “handle” for drag and drop functionality
Customizing Standard Reports – Move Columns Cont

Example - move Org from row to sections area

1. Standard view-Org in rows area

2. Use handle to drag and drop to sections area

3. Result – Org in sections area

To get back to standard view, use handle to drag and drop back down into rows section

For help email Financial.Reports@dartmouth.edu
Customizing Standard Reports – Move Columns Cont

Example - move Org from row to prompts area

1. Standard view - Org in rows area

2. Use handle to drag and drop to prompts area

3. Result – Org in prompts area

To get back to standard view, use handle to drag and drop back down into rows section

For help email Financial.Reports@dartmouth.edu
Customizing Standard Reports – Saving

To save a customized report, after all changes are made

1. Choose Page Options

2. Save Current Customization

3. Name the filter/view combination

4. Choose for Me

5. (Optional) Check to set as Default. This means this filter/view will run when the report link is clicked

6. Click OK to save.

Page Options Icon is on top right of screen

For help email Financial.Reports@dartmouth.edu
Customizing Standard Reports – Run Saved Report

To run a saved report, open the report link and choose Page Options -> Apply Saved Customization -> saved report name:

- This will automatically run the customized report using saved filters, and return data in the saved report view format. Data will be refreshed with up-to-date information.

To adjust the filters of a saved report before processing, choose a saved report and click here to cancel processing. Change your filters and click Apply to process.

- For example, a report of several funding values could be saved and selected, but the Searching cancelled so the user could update the specific period to run.

- Note: Saved selections are specific to each report. For example, customizations saved under the GL Transactions report will not be available under GL Rollup Report.

For help email Financial.Reports@dartmouth.edu
Customizing Standard Reports - Manage

- To manage your saved report and filters, open the report link and choose Page Options → Edit Saved Customizations

- Rename an existing saved report

- Radio button controls which saved report is the default

- Click OK to save your changes

- Delete an existing saved report

For help email Financial.Reports@dartmouth.edu
EXITING IRA (Sign Out)

- Close all open IRA browser windows except the main dashboard page.
- Select the Sign Out option at the top right of the main IRA browser window.

---

For your security, please **completely exit your web browser** if you are finished accessing restricted applications. To exit, go to the File menu of your Web browser and choose Exit, Close or Quit.

To log out of the Dartmouth Web Authentication system, click here. You must also clear your Kerberos ticket or remove your eToken to clear any credentials that have been temporarily stored on this computer.

For help email Financial.Reports@dartmouth.edu
IRA - ADDITIONAL NAVIGATION OPTIONS
Navigation - Home Page

Allows you to quickly navigate to “Recent” places or to “Popular” items (for your group)
Navigation - Home Page

Quick link to do your own Analysis

Catalog folders

Links to tutorials and help

For help email Financial.Reports@dartmouth.edu
NAVIGATION – Catalog

A feature of the Catalog is the ability to view the details of a folder in various ways (e.g., Descriptive with larger icons, Details, List).

For help email Financial.Reports@dartmouth.edu
NAVIGATION – Catalog

is where custom reports are stored

For help email Financial.Reports@dartmouth.edu
NAVIGATION – Favorites

Allows you to save quick links to your Favorites Page

When you are on a dashboard, you can use the “Add to Favorites” function

or from the Catalog, you can right click on an Analysis and select “Add to Favorites”
NAVIGATION – Favorites

Allows you to save quick links to your Favorites Page. When you are on a dashboard, you can use the "Add to Favorites" function. From the Catalog, you can right-click on an Analysis and select "Add to Favorites".

Allows you to organize your favorites in "folders".

For help email Financial.Reports@dartmouth.edu
NAVIGATION – Dashboards

Easiest way to access the available dashboards

Note that you may have to expand the “Dashboards” listing
NAVIGATION – Open

Provides another way to access available Dashboards
Displays most “Recent” and “Most Popular”

For help email Financial.Reports@dartmouth.edu
NAVIGATION – New

Create a new Analysis/ (Report)

Available “Subject” Areas

This topic covered in the Advanced IRA Class

For help email Financial.Reports@dartmouth.edu